Office Word 2007
Lab 2

Revising and Refining a Document

- In this lab, the student will learn more about editing documents
- They will learn to use many more of the formatting features included in Office Word 2007 to add style and interest to documents
- Formatting features can greatly improve the appearance and design of any document

Objectives

1. Use Spelling and Grammar tool and the Thesaurus
2. Move, cut and copy text and formats
3. Control document paging
4. Find and replace text
5. Insert the current date
6. Change indents, line spacing, and margins
7. Create a tabbed table
8. Add color highlighting and underlines to text
9. Create numbered and bulleted lists
10. Create and use Building Blocks
11. Insert and modify Shape
12. Edit in Print Preview
13. Print a document
Concept Preview

- **Thesaurus** - Word's Thesaurus is a reference tool that provides synonyms, antonyms, and related words for a selected word or phrase.
- **Move and Copy** - Text and graphic selections can be moved or copied to new locations in a document or between documents, saving you time by not having to retype the same information.
- **Page Break** - A page break marks the point at which one page ends and another begins. Two types of page breaks can be used in a document: soft page breaks and hard page breaks.
- **Find and Replace** - To make editing easier, you can use the Find and Replace feature to find text in a document and replace it with other text as directed.
- **Field** - A field is a placeholder that instructs Word to insert information into a document.

Concept Preview

- **Indents** - To help your reader find information quickly, you can indent paragraphs from the margins. Indenting paragraphs sets them off from the rest of the document.
- **Line Spacing** - Adjusting the line spacing, or the vertical space between lines of text and paragraphs, helps set off areas of text from others and when increased or decreased makes it easier to read and edit text.
- **Bulleted and Numbered Lists** - Whenever possible, add bullets or numbers before items in a list to organize information and make your writing clear and easy to read.
- **Sort** - Word can quickly arrange or sort text, numbers, or data in lists or tables in alphabetical, numeric, or date order based on the first character in each paragraph.
- **Page Margin** - The page margin is the blank space around the edge of the page. Standard single-sided documents have four margins: top, bottom, left, and right.
Revising a Document

Your Turn

1. Start Office Word 2007 and open the file wd02_Tour Letter.
2. Open the Review tab.
3. Click .
4. If necessary, select the Check grammar option to turn on grammar checking.
5. Click .
6. Edit the spelling of the word to Machu in the Not in Dictionary box.
7. Click .
8. Click AutoCorrect .
9. Respond to the spelling and grammar checker by taking the actions in the table above for the five identified errors.
10. Click in response to the message telling you that the spelling and grammar check is complete.
11. Move to the top of the document.
Spell-Checking the Entire Document

Spelling and Grammar Dialog Box

- **Suggestions list box**
  - Displays words located in the dictionary
  - Most likely match is highlighted

- **Change spelling of the word to one of the suggested spellings**
Concept 1

**Thesaurus**

- A reference tool used for selected words or phrases

- Provides
  - **Synonyms** (words with a similar meaning: happy / cheerful)
  - **Antonyms** (words with an opposite meaning: happy / sad)
  - **Related words**

- Enhances your document by adding interest and variety

---

**Your Turn**

1. Right-click on the word “ideas” (first paragraph, second sentence) to display the context menu.
2. Select **Synonyms** on the Context menu.
3. Choose “dreams”.
4. Click on the word “happy” (first sentence, second paragraph).
5. Click in the **[Review tab]** Proofing group.
6. Choose “pleased”.
7. Click to display the list for the word “happy.”
8. Open the “pleased” synonym drop-down menu.
9. Choose **Insert**.
10. Close the **Research** task pane.
11. Move to the top of the document and save the revised document as **Tour Letter2** to the appropriate data file location.
Synonym Submenu

Research Pane
Moving and Copying Selections

- Using copy and paste
- Using cut and paste

Concept 2

Move and Copy

- Text and graphics can be moved or copied
  - To a new location
  - Between documents
- Source – original location
- Destination – new location
- Clipboards
  - System
  - Office
Your turn – Copy & Paste

1. Select “Adventure Travel Tours” (first paragraph, last sentence).
2. Click Copy in Clipboard group of the Home tab.
3. Move to the beginning of the word “journey” (last paragraph, first sentence).
4. Click in the Clipboard group.
5. Click the Paste Options button.
6. Click outside the menu to close it.
7. Select “us” (last sentence).
8. Right-click on the selection and choose Paste from the context menu.

Using Copy and Paste

- **Copy selection** is inserted at specified location
- **Paste Options** button appears automatically
Paste Options

- Insert item with the same source formatting or…
- Change item to formatting of surrounding destination text or…
- Insert text only
  - Used when there is a combination of text and graphics

Using Cut and Paste
Your turn – Cut & Paste

1. Select the second paragraph.
2. Click Cut in the Clipboard group.
3. Move to the beginning of the paragraph below the list of presentation dates.
4. Press Ctrl + V.
5. If necessary, scroll down to view the pasted paragraph.

TIP: The Cut keyboard shortcut is Ctrl + X. You also can choose Cut from the context menu.

Using Drag and Drop

- Most useful for copying or moving short distances
- Point to a selection
- Drag it to new location
Using Drag and Drop

1. To use drag and drop to move a selection, point to the selection and drag it to the location where you want the selection.

2. The mouse pointer appears as you drag, and a temporary insertion point shows you where the text will be placed when you release the mouse button.

   a. Select “directly” (last word in last paragraph).
   b. Drag the selection to before “at” in the same sentence.

TIP: You also can move or copy a selection by holding down the right mouse button while dragging. When you release the mouse button, a context menu appears with the available move and copy options.

Using Drag and Drop

TIP:
You also can move or copy a selection by holding down the right mouse button while dragging. When you release the mouse button, a context menu appears with the available move and copy options.
Copying Between Documents

1. All Office 2007 applications allow you to open and use multiple files at the same time; you can easily copy between documents.

2. You can view two documents in the same window by using the [View side by side] feature.

3. The active window is the window you are currently working with.

4. When viewing documents side by side, the windows are synchronized, meaning both windows will act the same.
Copying Between Documents

1. Move to the top of the document.
2. Click \text{Save}.
3. Open the \texttt{wd02\_Flyer2} document.
4. Open the View tab.
5. Click \text{View Side by Side} in the Window group.
6. Reduce the zoom to 75%.
7. Go to the bottom of the \texttt{wd02\_Flyer} window and replace \texttt{Student Name} with your name.
8. Click \text{to display the Window group commands.}
9. Click \text{Synchronous Scrolling} to turn off this feature.
10. Scroll to the top of the \texttt{wd02\_Flyer2} document.
11. Click in the \texttt{Tour Letter2} window to make it active and press \text{Ctrl} + \text{End} to move to the last (blank) line of the document.
12. Click in the \texttt{Flyer2} window to make it active and drag in the left margin to select the entire flyer.
13. \text{Right-drag} the selection to the blank line at the end of the letter.
14. Release the mouse button and choose \text{Copy Here} from the context menu.
15. Click \text{Maximize} in the \texttt{Tour Letter2} title bar to maximize the application window.

Controlling Document Paging

- New page started when text extends beyond bottom margin

- Beginning of a new page is identified by a page break
**Concept 3**

**Page Break**

- Point where one page ends and another begins
- Two types
  - **Soft page break**
    - Done automatically
  - **Hard page break**
    - Done manually \([ Ctrl + Enter ]\)
    - Location is never moved regardless of changes made to the document

---

**Inserting a Hard Page Break**

1. Move to the beginning of the first line of the flyer.
2. Press \([ Ctrl + Enter ]\).
3. Save the document again.
Finding and Replacing Text

**TIP:** The keyboard shortcut is [Ctrl]+F.

Searching

1. Switch to Print Layout view at 100% zoom.
2. Move the insertion point to the top of the document.
3. Click **Find** in the Editing group.
4. Click **More >>**
5. Click **<<Less** to close the advanced search options.
6. Type *trip* in the [Find What] text box.
7. Click **Find Next**
8. Continue to click **Find Next** to locate all occurrences of the word.
9. Click **OK** when Word indicates the entire document has been searched.
10. Click **Highlight All**.
11. Choose [Highlight All].
12. If necessary, scroll the document to view the first five highlighted words.
13. Scroll to the end of the document to see the highlighted word.
14. Click **Clear Highlighting** and choose [Clear Highlighting].
Concept 4

Find and Replace

- Find text in a document and replace it with other text
- Can find and replace …
  - Special formatting such as bold text
  - Formatting marks
  - Special characters
  - Symbols

Search the Entire Document
Search Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Effect On Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match case</td>
<td>Finds only those words in which the capitalization matches the text you typed.</td>
</tr>
<tr>
<td>Find whole words only</td>
<td>Finds matches that are whole words and not part of a larger word. For example, finds “cat” only and not “catastrophe” too.</td>
</tr>
<tr>
<td>Use wildcards</td>
<td>Fine-tunes a search; for example, c?t finds “cat” and “cot” (one-character matches), while c*t finds “cat” and “court” (searches for one or more characters).</td>
</tr>
<tr>
<td>Sounds like (English)</td>
<td>Finds words that sound like the word you type; very helpful if you do not know the correct spelling of the word you want to find.</td>
</tr>
<tr>
<td>Find all word forms (English)</td>
<td>Finds and replaces all forms of a word; for example, “buy” will replace “purchase,” and “bought” will replace “purchased.”</td>
</tr>
</tbody>
</table>

The Reading Highlight Feature
Replacing Text

- **Replace With** text box allows you to enter replacement text.

- Text must be entered exactly as you want it to appear.

---

1. Move to the top of the document.
2. Open the Replace tab.
3. Type *tour* in the [Replace with] text box.
4. Click **Find Next**.
5. Click **Replace**.
6. Click **Find Next** to skip this occurrence and locate the next occurrence.
7. Replace the next located occurrence.
8. Continue to review the document, replacing all other occurrences of the word “trip” with “tour,” except on the final line of the flyer.
9. Click **Find Next**.
10. Click **OK** to close the information dialog box.
11. Click **Close** to close the Find and Replace dialog box.
Inserting the Current Date

The Date and Time command on the [Insert tab] inserts the current date as maintained by your computer system into your document at the location of the insertion point.

- A field is a placeholder that instructs Word to insert information into a document.
- The field code contains the directions as to the type of information to insert or action to perform.
- Field codes appear between curly brackets { }, also called braces.
- The information that is displayed as a result of the field code is called the field result.
- When you point to a field, the entire entry is shaded to identify the entry as a field.

TIP: The keyboard shortcut for displaying and hiding all of the field codes in a document Alt + F9.
Inserting Current Date

1. If necessary, move to the “D” in “Dear” at the top of the letter.
2. Press Enter 2 times to insert two blank lines.
3. Move to the first blank line.
4. Click Date & Time in the Text group of the Insert tab.
5. Select the third format setting.
6. If necessary, select Update Automatically to display the checkmark.
7. Click OK
8. Point to the date. Click on the date.
9. Right-click on the date and choose Toggle Field Codes from the context menu.
10. Press Shift + F9 to display the field result again.
11. Save the document.
Field Code

- Many are automatically inserted
- Makes it easier and faster to perform many common functions

Modifying Page Layout

1. Paragraph settings
   - Indents
   - Line spacing
2. Page margin settings
3. Page background colors
4. Themes
5. Vertical alignment
6. Orientation of text
Concept 6

**Indents**

- Indents help the reader find information quickly
- Indent paragraphs from the margins
- Indenting paragraphs sets them off from the rest of the document

### Types of Indents

<table>
<thead>
<tr>
<th>Indent</th>
<th>Effect on Text</th>
<th>Indent</th>
<th>Effect on Text</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Left</strong></td>
<td>Indents the entire paragraph from the left margin. To &quot;outdent&quot; or extend the paragraph into the left margin, use a negative value for the left indent.</td>
<td><strong>First Line</strong></td>
<td>Indents the first line of the paragraph. All following lines are aligned with the left margin.</td>
</tr>
<tr>
<td><strong>Right</strong></td>
<td>Indents the entire paragraph from the right margin. To outdent or extend the paragraph into the right margin, use a negative value for the right indent.</td>
<td><strong>Hanging</strong></td>
<td>Indents all lines after the first line of the paragraph. The first line is aligned with the left margin. A hanging indent is typically used for bulleted and numbered lists.</td>
</tr>
</tbody>
</table>
Simultaneous Indenting

Dragging indent marker indents the first line of each paragraph in a selection.

First line of each paragraph in selection is indented 0.5 inch.

Setting Tab Stops

<table>
<thead>
<tr>
<th>Tab Type</th>
<th>Tab Mark</th>
<th>Effects On Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>[a]</td>
<td>Extends text to right from tab stop</td>
</tr>
<tr>
<td>Center</td>
<td>[b]</td>
<td>Aligns text centered on tab stop</td>
</tr>
<tr>
<td>Right</td>
<td>[c]</td>
<td>Extends text to left from tab stop</td>
</tr>
<tr>
<td>Decimal</td>
<td>[d]</td>
<td>Aligns text with decimal point</td>
</tr>
<tr>
<td>Bar</td>
<td>[e]</td>
<td>Draws a vertical line through text at tab stop</td>
</tr>
</tbody>
</table>
Adding Leader Characters

Selected tab leader style added between each column of tabbed data

In appreciation of your past patronage, we are pleased to offer you a 10% discount off the price of anyadtent in our new package. The discount at all range at 10% off on all package of showing dates.

Prospects to this letter to qualify for the discount.

Our vacation tours are professionally developed solely for your enjoyment. We include almost everything in the price of your tour while giving you the best possible value for your dollar. All tours include these features:

- Professional trip manager and local guides
- All commercial round-trip tickets
- All ground fees, excursions, transfers and trip

We hope to see you again in the year for another special Adventure Travel Tour. Make new Adventure Travel Tours each day of an adventure. For reservations, please see your travel agent or contact Adventure Travel Tours directly at 800-555-0000.
Changing Line Spacing

Adjusting the line spacing, or the vertical space between lines of text, helps set off areas of text from others and when increased makes it easier to read and edit text.

Line Spacing

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>Single line spacing.</td>
</tr>
<tr>
<td>1.5 lines</td>
<td>Spacing is one and a half times that of single line spacing.</td>
</tr>
<tr>
<td>Double (2.0)</td>
<td>Spacing is twice that of single line spacing.</td>
</tr>
<tr>
<td>At least</td>
<td>Uses a value specified in points as the minimum line spacing that is needed to fit the largest font or graphic on the line.</td>
</tr>
<tr>
<td>Exactly</td>
<td>Uses a value specified in points as a fixed line spacing amount that is not adjusted, making all lines evenly spaced. Graphics or text that is too large will appear clipped</td>
</tr>
<tr>
<td>Multiple</td>
<td>Uses a percentage value to increase or decrease the spacing from single spacing. For example, 1.3 will increase the spacing by 33 percent.</td>
</tr>
</tbody>
</table>
Line Spacing

TIP: You can use Ctrl + # to change the line spacing to the number specified.
TRY: Double-spacing Ctrl + # 2

More Character Formatting

- Color
- Highlighting
- Underlining
Color Highlighting

Applying color shading or highlighting behind text is commonly used to identify areas of text that you want to stand out.

Underline – Bold - Italics

Our vacation tours are professionally planned, as well as a variety of

organized activities.
Copying Formats with Format Painter

- Applies the formats associated with the current selection to new selections
- Quickly applies the same format to other text
- Can be applied to entire paragraphs, characters, or words

Creating Lists

Creating a List Using Word
- Topic One
- Topic Two
- Topic Three
- Topic Four
- Topic Five
Concept 8

**Bulleted and Numbered Lists**

- Lists organizes information
- Helps to make things clear
- Word includes many basic bullet and number formats
- Can create customized designs

Types of Lists

- **Bulleted list**
- **Numbered list**
- **Outline numbered list**
Numbering a List

- Bullet and number formats indent the items automatically
- Numbering gallery available
  - Contains seven built-in styles
  - Numbers followed by periods is the default
- Other options
  - Change indent level
  - Customize appearance
  - Set a new start number
Concept 9

Word can arrange or sort text, numbers, or data in **lists** or **tables**
- Alphabetical order
- Numeric order
- Date order

Sort order
- Ascending
- Descending
## Sorting Rules

<table>
<thead>
<tr>
<th>Sort By</th>
<th>Rules</th>
</tr>
</thead>
</table>
| **Text** | • First, items beginning with punctuation marks or symbols (such as !, #, $, %, or &) are sorted.  
• Second, items beginning with numbers are sorted. Dates are treated as three-digit numbers.  
• Third, items beginning with letters are sorted. |
| **Numbers** | All characters except numbers are ignored. The numbers can be in any location in a paragraph. |
| **Date** | Valid date separators include hyphens, forward slashes (/), commas, and periods. Colons (:) are valid time separators. If unable to recognize a date or time, Word places the item at the beginning or end of the list (depending on whether you are sorting in ascending or descending order). |
| **Field results** | If an entire field (such as a last name) is the same for two items, Word next evaluates subsequent fields (such as a first name) according to the specified sort options. |

### Sorting a List

<table>
<thead>
<tr>
<th>Original List</th>
<th>Ascending</th>
<th>Descending</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>10</td>
<td>100</td>
</tr>
<tr>
<td>50</td>
<td>20</td>
<td>90</td>
</tr>
<tr>
<td>20</td>
<td>30</td>
<td>80</td>
</tr>
<tr>
<td>70</td>
<td>40</td>
<td>70</td>
</tr>
<tr>
<td>90</td>
<td>50</td>
<td>60</td>
</tr>
<tr>
<td>30</td>
<td>60</td>
<td>50</td>
</tr>
<tr>
<td>40</td>
<td>70</td>
<td>40</td>
</tr>
<tr>
<td>10</td>
<td>80</td>
<td>30</td>
</tr>
<tr>
<td>80</td>
<td>90</td>
<td>20</td>
</tr>
<tr>
<td>60</td>
<td>100</td>
<td>10</td>
</tr>
</tbody>
</table>
Using Quick Parts

- Quickly insert text and graphics that you use frequently
- Includes reusable pieces of content or document parts
  - Called **building blocks**
    - Supplied with Word
    - Can create your own
  - Gives you a head start in creating content
Quick Parts: Sticky Note

Sticky Note
Enter your name and today's date
Using Supplied Building Blocks

Creating a Custom Building Block
Adding and Modifying Shapes

- Ready made shapes supplied by Word
- To see and create, use **Print Layout** view
- In Draft view, AutoShapes are not displayed
Inserting a Shape

Menu of shapes is divided into 7 categories

Wave shape

Filling the Shape with Color

Adds fill color

Gradient fill and line color added to shape
Adding Text to a Shape

Presentation dates and times are January 5 at 8:00 p.m., February 3 at 7:30 p.m., and March 8 at 8:00 p.m. All presentations are held at convenient hotel locations in downtown Los Angeles, Santa Clara, and at the LAX airport.

Call Student Name at 1-800-555-0004 for presentation locations, a full color brochure, and itinerary information, costs, and trip dates.

Visit our Web site at www.adventuretraveltours.com

URL is formatted as a hyperlink

Moving an Object

Activities while exploring the world:

- India Wildlife Adventure
- Inca Trail to Machu Picchu
- Safari in Tanzania
- Costa Rica Rivers and Rainforests

Presentation dates and times are January 5 at 8:00 p.m., February 3 at 7:30 p.m., and March 8 at 8:00 p.m. All presentations are held at convenient hotel locations in downtown Los Angeles, Santa Clara, and at the LAX airport.

Call Student Name at 1-800-555-0004 for presentation locations, a full color brochure, and itinerary information, costs, and trip dates.

Visit our Web site at www.adventuretraveltours.com

Shape moved
Setting Page Margins

- A blank space around the edge of a page
- Standard single-sided documents have four margins:
  - Top
  - Bottom
  - Left
  - Right
- Gutter margins are used for book binding.

Concept 10

Page Margin
Margins

- Default document setting for the left and right margins is 1 inch
- Use the Page Setup group to make changes
- Mirrored option used for double-sided documents with facing pages, such as a book

Printing the Document

Quick Print

[Image of Quick Print options]

- Print: Select a printer, number of copies, and other printing options before printing.
- Quick Print: Send the presentation directly to the default printer without making changes.
- Print Preview: Preview and make changes to pages before printing.
Key Terms

- active window
- antonym
- building blocks
- bulleted list
- case sensitive
- destination
- drag and drop
- Field
- field code
- field result
- Format Painter
- hard page break
- hyperlink
- Indent
- leader character
- line spacing
- numbered list
- Office clipboard
- outline numbered list
- page break
- page margin
- soft page break
- Sort
- source
- synchronized
- synonym
- system Clipboard
- tab stop
- thesaurus
- URL

FAQs

1. Why are some words underlined in red in my document?
2. How many items can the Office Clipboard store?
3. What is the difference between Copy and Paste and Cut and Paste?
4. Is there a quick way to move a word to a different location in the document?
5. How can I synchronize windows when I am copying between documents?
6. What is the difference between a soft page break and a hard page break?
7. How does the Find and Replace feature work?
8. How can I insert the current date on my document? Can the date be updated automatically?
9. What are the types of paragraph indents available in Word 2007?
10. What is the Format Painter?
11. What are tab stops and how do I use them?
FAQs

12. What are Leader characters?
13. My document looks too crowded. How can I add more space between the lines of text?
14. How does the Quick Parts feature work?
15. I created a list but it is not in order. How can I rearrange the order?

Discussion Questions

1. Explain how to use Word's five tab types. Give examples of each.
2. Describe what custom building blocks you can create for a report.
3. Explain how you can open and use multiple Word files at the same time.
4. Discuss what features in Word can help you to create books and magazines.
5. The Find and Replace feature and the Format Painter allow you to modify your document. Explain how to use each of these features.
6. You want to make your class report look more exciting. What features in Word 2007 can you use to enhance your document?